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Chapter 1: Getting Started with Word

In this chapter, you meet the Word working environment, including the Word Start screen
and Backstage view, and you learn the essentials of navigating the interface with the
keyboard and mouse and entering text using the keyboard. You also learn about using Word
on tablets, phones, OneDrive, and Teams.
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Open Word and Use the Start Screen

Microsoft Word is the world’s most widely used word processing app. As of this writing, the
current version of Word is Word 2019, which runs on Windows 10 and on macOS. This book
focuses on Word 2019 for Windows. Microsoft also provides versions of Word for Apple iOS
devices, which are the iPhone and iPod touch; for iPad OS, the iPad’s operating system; and
for Android, Google’s operating system for smartphones and tablets.

To use Word, you first launch it. This section shows you how to pin Word to the Start menu
or to the taskbar, and how to launch it from those locations.



Open Word and Use the Start Screen

Pin Word to the Start Menu or to the Taskbar
© Click Start (2).
The Start menu opens.
© Locate the Word icon (=) and entry. For example, scroll down.
Note: You can click Word (&) to launch Word.
© Right-click Word ().
The context menu opens.

© To pin Word to the taskbar, click or highlight More, and then click Pin to taskbar.
© Click Pin to Start.

Windows pins Word to the Start menu.




Launch Word from the Start Menu

© Click Start (2).
The Start menu opens.
© Click Word (=).
Word opens.

Note: You can get Word either by buying an Office 2019 perpetual license or by paying for a
Microsoft 365 subscription. Microsoft is gradually moving to the subscription model, and
this is generally a better choice because the software receives ongoing updates as long as
you subscribe, whereas the perpetual license receives only bug fixes and some updates.

Launch Word from the Taskbar

© Click Word (=) on the taskbar.
Word opens.
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Meet the Home Screen and Close Word

When Word opens, it displays the Home screen.
O If you have signed in to Microsoft 365, your ID appears here.
@ The New area presents templates you can click to start a new document.
@ You can click Search and type a search term to search for a document or template.
© The Recent list shows recent documents. You can click a document to open it.
@ You can click New to create other types of new documents.
@ You can click Open to open other existing documents.

@ Click Close (.).

What do the Pinned tab and the Shared with Me tab contain?

The Pinned tab contains a list of documents you have “pinned” to keep them available. This
gives you an easy way to open documents you use often.

The Shared with Me tab contains a list of documents that others have shared with you via
Microsoft’s OneDrive online service or through other means.

Understanding Office and the Cloud

Word and the other Microsoft Office apps, such as the Excel spreadsheet app and the
PowerPoint presentation app, offer full integration with Microsoft’s OneDrive online service,
SharePoint servers, and Teams collaboration app. This integration enables you to work no
matter where you are and which type of device you have available. For example, you can
sign in to OneDrive on your laptop or iPad and get to work in Word; or you can sign in to
Teams and open a Word document for editing directly in the app.

Sign In to the Cloud
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Signing in to Office.com or your Microsoft 365 subscription connects your Office programs
to the world beyond your computer. Office Online offers free access to the online, limited-



edition versions of Word and other Office programs that you can use on any computer.
Purchasing a Microsoft 365 subscription gives you access to full versions of the Office
desktop programs and the online versions of the products. Signing in gives you access to
online pictures and clip art stored at Office.com and enables Word to synchronize files
between your computer, OneDrive, and SharePoint.

OneDrive Storage Space
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Subscriptions to Microsoft 365 include space on Microsoft’s OneDrive cloud storage service.
The amount varies depending on the plan; for example, the Microsoft 365 Personal plan
gives one person 1terabyte—1TB, 1000 GB—of storage space, and the Microsoft 365 Family
plan gives up to six family members 1 TB each. Word and the other apps save all documents
by default to OneDrive so that you can access your documents from anywhere.

Using Office Online Apps
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You can open and edit Word, Excel, OneNote, and PowerPoint documents from OneDrive
using Office online apps, which are scaled-down editions of Office programs that you can
use to easily review documents and make minor changes.

Take Your Personal Settings with You Everywhere

Word keeps track of personal settings like your recently used files and favorite templates
and makes them available from any computer. When you open a document, Word gives you
an easy way to return to the last location you were editing. This makes it easy for you to get
back to work when you move from one computer or device to another.



Your Documents Are Always Up to Date
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Word saves your documents by default in the OneDrive folder on your computer, from
which you can access them quickly. Windows then synchronizes this folder with OneDrive in
the background.

Share Your Documents from Anywhere

o

Send Link
Repert 1,806k
o, 5 -
(&2} Ar Tt
maria_x_joneyoutiook .:'"l x

o maria_z_jonesioutiook.c..
o £ jlormidBon bk L O

D Sends Copy

You can share your documents both from within Word and from OneDrive. If the document
is stored on OneDrive, you can send the recipient a link so that they can work with the
original document. If the document is stored on your PC, you can send the document itself;
you can also send the document from OneDrive to give the recipient a separate copy to
work with.

Take Advantage of the Office Store
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The Office Store contains add-in applications that work with Word and the other Office
apps. For example, the dictionary you use to look up words in Word does not automatically
install when you install the program. But when you need an add-on for Word, you can
download it from the Office Store.

Explore the Word Window

Like most of the other Office apps, Word’s interface uses the Ribbon, a control strip across
the top of the window, and a Quick Access Toolbar that appears either in the window’s title
bar or below the Ribbon. The Ribbon contains most commands available in Word, and the
Quick Access Toolbar contains frequently used commands.

Product Development
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@ Quick Access Toolbar
A Contains buttons that perform common actions.

2 Ribbon



Contains buttons organized in tabs, groups, and commands.
@ Dialog Box Launcher

Appears in the lower-right corner of many groups on the Ribbon. Clicking this button ()
opens a dialog box or task pane that provides more options.

& Document Area

The area where you type and edit content. The insertion point, a blinking vertical bar, shows
where text will appear when you type.

© Status Bar

Displays document information and the location of the insertion point.

@ View Shortcuts

Contains buttons to switch among Word’s different views of a document.
O Zoom Controls

Changes the magnification of a document.

© Microsoft 365 Indicator

If your name appears, you are signed in to your Microsoft 365 subscription. You can click . to
display a menu that enables you to manage your Microsoft account settings. If you are not
signed in, this area shows a Sign In link.

@ App Window Controls
© Title Bar

These buttons enable you to control the appearance of the app window. You can minimize
the Ribbon, and you can minimize, maximize, restore, or close the app window.

Shows the document and app titles.

Sign In to Your Account

You can use Office.com or your Microsoft 365 subscription to work from anywhere. Once
you sign in, you can use the free Office online apps, such as the Word app. Word remembers
some of your personal settings such as your Recent Documents list so that you always have
access to them. Desktop product users typically sign in using a Microsoft 365 subscription.

When you work offline, Word creates, saves, and opens your files from the local OneDrive
folder. When you reconnect, Word uploads your changes to the cloud automatically.



Sign In to Your Account
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@© Open Word.
The Word Home screen appears.

© Click the Sign in link.

Note: If you are viewing a document, you can click the Sign in link in the upper-right corner
of the screen.
The Sign In window appears.

© Type the Microsoft account email address associated with your Microsoft 365
subscription.

O Click Next.
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Note: If the Enter Password window appears, type your password, and click Sign In.

© Your name in this area indicates that you have signed in to Microsoft 365.

© If you need to sign out, click your name, and then click Sign out in the pop-up panel that
opens.

Work with Backstage View

You can click File at the left end of the Ribbon to display Backstage view. Backstage is the
place to go when you need to manage documents or change program behavior. In
Backstage view, you find a list of actions that you can use to open, save, print, remove
sensitive information, and distribute documents as well as set Word program behavior
options. You can also use Backstage to manage the places on your PC’s hard drive, on your
network, or in your OneDrive space that you use to store documents.

Work with Backstage View
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© Click File.
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Backstage view appears.

@ The left pane acts as a menu for navigation and commands for manipulating Word and the
active document.

@ This pane lets you quickly create new documents and open recent documents, frequently
used documents you have “pinned,” and documents shared with you.

@ The Search box enables you to search by keywords for documents.

@ Click New.
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The New pane appears.

@ You can double-click a template in the New area to quickly create a document based on
that template.

© You can click Search for online templates and type search terms to search for online
templates.
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@ You can click a Suggested Search to display templates in that category, such as Resumes
and Cover Letters.

© Click Info.

Info

The Info pane appears.

© You can view information about the document and its properties, such as its size and last
modified date.

@ You can take actions, such as inspecting the document or managing it.

© Click Back (&).

Word closes Backstage view and redisplays the open document.

What does the Options link in Backstage do?
Clicking Options in the left pane in Backstage opens the Word Options dialog box. This
dialog box contains scores of options for configuring Word to look and behave the way you

prefer. You will explore the Word Options dialog box at various points throughout this
book.

Change the Color Scheme and Background

The Office apps include several themes that you can apply from the Account screen in
Backstage view or from the Word Options dialog box. The Colorful theme gives each app a
different main color—navy blue for Word, forest green for Excel, and so on. The Dark Gray
theme, the Black theme, and the White theme apply the name’s shade to each app.

You can also apply an Office background, such as Clouds or Tree Rings, to an app. The
background graphics appear on the right side of the title bar.
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Change the Color Scheme and Background
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Note: The color scheme and background apply to all the Office apps, so if you change the
color scheme and background in Word, the changes appear in Excel, PowerPoint, and the
other apps as well.

© Click File.
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Backstage view opens.

@ Click Account.
The Account pane appears.

© Click Office Theme (.).
The Office Theme drop-down list opens.

O Click the Office theme you want.
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Word takes on the colors of the theme you chose.
Note: Some theme changes are more subtle than others.
© Click Office Background (.).

O Move the pointer ([}) over a choice in the menu to highlight that choice.

© A background pattern appears at the top of the window. The pattern remains as you work
on documents.

@ Click the pattern you want to use, or click No Background.

© Click Back (@) to return to your document.
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The Office theme and background you selected appear.

0 The background appears in the title bar.

What is the point of the Office backgrounds?



The backgrounds add a small amount of visual interest to the app’s interface. Some people
like the backgrounds; others consider them pointless.

Locate Commands on the Ribbon

Word’s Ribbon contains a huge number of commands, and it can be difficult to remember
where to find a command you do not use frequently. To help you locate Ribbon commands,
Word provides the Search feature.

You can still use the Ribbon directly, as described in the next section, “Give Commands
Using the Keyboard and Mouse.” The Search feature is most useful when you are not sure
where on the Ribbon to find the command you need.

Locate Commands on the Ribbon
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© Open a document.
Note: See Chapter 2 for details on opening documents.

@ Click Search (»).
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The Search pop-up panel opens.
@ The Recently Used Actions list shows some recent actions you have taken.
© The Suggested Actions list suggests options that may be useful.
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© Type a brief description or a keyword describing what you want to do.
@ The Actions list shows matches for what you typed.
© Click a command to perform its action.

@ If the command includes an arrow (.), you can either click the command itself to perform
its default action, or click . to display a list of all its actions, and then click the action you

want to perform.

Note: If you click a command that has no default action, Word displays the list of all the

command’s actions. You can then click the action you want to perform.
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© The program performs the action you clicked. In this example, Word places a border
around the first paragraph.

TIPS

Will I need to type a description of the action | want to take if it is the
same action | have previously taken?

No. The Search box remembers your previous searches and displays them on the menu that
appears when you perform step 2.

Can | delete my previous searches?

No. The Search feature retains your searches in the Recently Used section of the menu that
appears when you click in the search box.

Give Commands Using the Keyboard and Mouse

You can keep your hands on your keyboard and select commands from the Ribbon or the
Quick Access Toolbar, or you can use the mouse.

The Ribbon contains buttons organized in tabs, groups, and commands. Tabs appear across
the top of the Ribbon and contain groups of related commands. Groups organize related
commands; the group name appears below the group. Commands appear within each
group. By default, the Quick Access Toolbar appears above the Ribbon and contains the
AutoSave switch and the Save, Undo, and Redo commands. To customize the Ribbon or the
Quick Access Toolbar, see Chapter 11.
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Give Commands Using the Keyboard and Mouse

Industrial Trends on the Yucatan Peninsula
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Give Commands with the Keyboard

© If appropriate for the command you intend to use, place the insertion point in the right
word or paragraph.

© Press i on the keyboard.
@ Shortcut letters appear on the Ribbon.
© Shortcut numbers appear on the Quick Access Toolbar.

© Type a letter to select a tab on the Ribbon.

This example uses i, which activates the Layout tab.
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The appropriate tab appears. In this example, the Layout tab appears.
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@ Letters for each command on that tab appear.

O Type the letter or letters to select the command you want to run.
For example, type SA to select the Space After box in the Paragraph group.
If appropriate, Word displays options for the command you selected.

© Type a letter or use the arrow keys on the keyboard to select an option.
Word performs the command you selected, applying the option you chose.

Industrial Trends on the Yucatan Peninsula
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Give Commands with the Mouse

@ Click in or select the text or paragraph you want to modify.
@ Click the tab containing the command you want to use.
© Move the pointer over the command you want to use.

© Word displays a ScreenTip describing the function of the button at which the pointer ([})
is pointing.

O Click the command. For example, click Bold (¢).

Industrial Trends on the Yucatan Peninsula
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@ Word performs the command you selected. In this example, Word applies boldface to the
selected text.

Note: If you selected text, click anywhere outside the text to continue working.

TIPS

Can | toggle between the document and the Ribbon using the
keyboard?

Yes. Each time you press i3, Word changes the focus of the program, switching among the
document, the status bar, and the Ribbon, in that order. When the focus is on the status bar
or the Ribbon, you can press ©=to move the focus to the next control, or press =+ e to
move the focus to the previous control.

What do the small down arrows below or beside buttons mean?

The small arrow (-) on a button means several choices are available. Click the button
directly to apply a default choice. Click . to view additional options. As you move the
pointer (i:i’) over the two parts of the button, Word highlights one or the other to alert you
that you have more choices.

Using Word on Tablets and Phones

You can use Word and the main Office apps on many tablets and phones as well as on PCs.
Windows 10 tablets can run the full versions of the apps, and you can switch to Touch mode
to make the interface easier to use with your fingers.

Microsoft also provides versions of Office for the iPad as well as the iPhone and iPod touch,
and for Android phones and tablets. These versions of the apps look substantially different
but provide most key features, including OneDrive connectivity, enabling you to continue
your work no matter where you are.
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Using Word on Tablets and Phones

Start a Program

© Tap Start ().

@ The Windows 10 Start menu for Tablet Mode appears.
Note: If Word (@) appears at the top of the Start menu, tap it.

© Tap All apps.
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The All Apps screen appears.

© Tap Word (=).
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Word opens.

© Tap the document you want to open.
The document opens.
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Using Touch/Mouse Mode
© Tap Customize Quick Access Toolbar (=).
© Tap Touch/Mouse Mode.

@ Word adds the Touch/Mouse Mode button to the Quick Access Toolbar.

Note: By default, each Office program displays the screen in Mouse mode.

© Tap Touch/Mouse Mode (&=).
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The Touch/Mouse pop-up panel appears.
© Tap Touch.

@ Word enlarges the Ribbon, adding space between the controls and collapsing some
groups into buttons, as needed to fit the screen.

© Tap to position the insertion point.

@ The on-screen keyboard appears.
You can then type on the on-screen keyboard.

Where can | get Word for iOS, iPadOS, and Android devices?

You can get Word for iOS or iPadOS from the App Store. On your iPhone, iPod touch, or
iPad, tap App Store on the Home screen, and then search for Microsoft Word. Similarly, you
can get Word for Android on the Play Store. On your Android device, tap Play Store on the
Home screen or the Apps screen, and then search for Microsoft Word.

You can use the basic features of these apps for free. But to use the apps’ full capabilities,
you must pay for a subscription.

Using Word in OneDrive and Microsoft Teams

From OneDrive, you can use the Word online app to open and edit Word documents with
the same basic editing tools you use in Microsoft Word. Similarly, after signing in to
Microsoft Teams, you can open a Word document for editing directly in Teams.

Both OneDrive and Teams provide a streamlined version of Word with fewer tools and
commands than the full desktop version.
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Using Word in OneDrive and Microsoft Teams
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Using Word Online from OneDrive

@ Sign in to OneDrive at onedrive.live.com.
@ Open the folder containing the document you want to open.

© Click the document you want to open.
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The document appears in the Word online app in another tab in the browser.

@ The insertion point appears, and you can edit as normal.
@ The Ribbon contains fewer tabs than in the desktop version.
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@ You can click Open in Desktop App to open the document in Word, assuming Word is
installed on the computer.

Note: The Word Online app automatically saves changes, so you do not need to save them
explicitly.

© When you finish working in the document, click Close (.).
The document closes.
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Using Word in Microsoft Teams

© Open Teams as usual. For example, click Start (=), and then click Microsoft Teams ().

Microsoft Teams opens.
© Click Teams (=) in the navigation bar.
The Teams list appears.

© Click the appropriate team.

O Click Files.
The Files pane appears.

© Click the file you want to open.
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The file opens, and you can work with it.

© For example, you can select a paragraph, and then apply a style to it.

Note: The Office Online apps inside Microsoft Teams automatically save changes, so you do
not need to save them explicitly.

© You can click Open in Desktop App to open the document in Word, assuming Word is
installed on the computer.

@ When you finish working with the file, click Close.
The document closes.

TIPS

What does the Conversation button in Microsoft Teams do?

Click Conversation to open the Conversation pane so that you can hold a conversation with
fellow team members. For example, you can discuss the changes needed to a document as
you work on it.

Work with the Mini Toolbar and Context Menus

Most of the formatting commands appear on the Home tab in Word, but you have
alternatives to format text. Without switching to the Home tab, you can format text using
the Mini Toolbar, which contains a combination of commands available primarily in the Font
and Paragraph groups on the Home tab.

You also can use the context menu to format text without switching to the Home tab or the
Review tab. The context menu contains the Mini Toolbar and a combination of commands
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available primarily in the Font group and the Paragraph group on the Home tab and on the
Review tab.

Work with the Mini Toolbar and Context Menus
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Work with the Mini Toolbar

© Select text.

@ The Mini Toolbar appears.
Note: If you slowly move the pointer ([?a‘) away from the selected text, the Mini Toolbar
becomes transparent and then disappears.

@ Click any command or button to perform the actions associated with the command or
button.
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© Word performs the action on the selected text.
@ The Mini Toolbar remains visible so that you can use it again if you want.
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Work with Context Menus

© Select text.
@ The Mini Toolbar appears.

© Right-click the selected text.
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@ The context menu opens.

Note: You can right-click anywhere in the document area, not just on selected text, to
display the Mini Toolbar and the context menu.

© Click a command or button to perform the associated action.
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How do | turn off the Mini Toolbar?

Click File and then click Options to open the Word Options dialog box. Click General in the
left pane to display the General category. Go to the User Interface Options section, and
then click Show Mini Toolbar on selection (- changes to ). Click OK. The Word Options

dialog box closes.

Enter Text in a Document

Word makes text entry as easy as possible. By default, Word uses Insert mode, in which any
text to the right of the insertion point moves along to accommodate the new text. When
the text reaches the end of the line, Word automatically wraps it to a new line, so you need
to press =3 only when you want to start a new paragraph.

When you want to use white space to align or position text, press e rather than =z See
Chapter 6, “Formatting Paragraphs,” for details on settings tabs.

Enter Text in a Document
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Type Text
© Type the text that you want to appear in your document.

@ The text appears to the left of the insertion point as you type.
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O As the insertion point reaches the end of the line, Word automatically starts a new one.
Press == only to start a new paragraph.
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Separate Information Using Tabs
@ Type a word or phrase.

@ Press .
To align text properly, you can press i1 to include white space between words.
Some white space appears between the last letter you typed and the insertion point.
© Type another word or phrase.
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Enter Text Automatically

© Begin typing a common word, phrase, or date.
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@ The AutoComplete feature suggests common words and phrases based on what you type.
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@ You can press == to let Word finish typing the word, phrase, or month for you.
You can keep typing to ignore Word’s suggestion.

Why should I use & rather than = to include white space between

words?

Typically, you include white space between words or phrases to align text in a columnar
fashion. Most fonts are proportional, and each character takes up a different amount of
space on a line, so using spaces does not usually align words exactly. Tabs, however, are set
at specific locations on a line, so when you press =3, the text will be aligned precisely with
the next tab stop. For details on tab settings, see Chapter 6.

Move the Insertion Point Around a Document

You can move the insertion point around a document quickly by using either the keyboard or
the mouse. Clicking with the mouse to place the insertion point works well when the new
location is already on the screen, but using keyboard shortcuts is usually quicker for moving
the insertion point longer distances. For example, pressing =2 + End is normally a faster way
of moving the insertion point to the end of a long document than scrolling and then clicking.
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Move the Insertion Point Around a Document
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Move the Insertion Point by One Character

© Note the location of the insertion point.

© Press .
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@ Word moves the insertion point one character to the right.
You can press &, i, or s to move the insertion point one character left, up, or down.

Pressing and holding any arrow key moves the insertion point repeatedly in the direction
of the arrow key.

You can press =1 + @ or cm + = to move the insertion point one word at a time to the right or
left.
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Note: When the insertion point is inside a word, pressing = + = moves the insertion point to
the beginning of that word.
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Move the Insertion Point by One Screen

© Note the last visible line on-screen.
© Press .
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© Word moves the insertion point down one screen.
© You can press = to move the insertion point up one screen.

@ You can click « to scroll up or - to scroll down one line at a time in a document.

How do | quickly move the insertion point to the beginning or the end
of a document or to a specific page?

Press n + i or mm + zm to move the insertion point to the beginning or to the end of a
document. To land on a specific page, press m to display the Go To dialog box, type the
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number of the page, and press ==. Press = + i1 to move the insertion point to the last place
you changed in your document. To move the insertion point to a specific location, use a
bookmark; see the section “Mark and Find Your Place with Bookmarks” in Chapter 3,
“Entering Text in Documents,” for details.

Switch Document Views

Word provides five main views for viewing your document: Print Layout view, Web Layout
view, Outline view, Draft view, and Read Mode view. The next section, “Understanding
Document Views,” explains the differences between the views, whereas this section shows
you how to switch among the views by using the buttons on the status bar and on the View
tab of the Ribbon.

Switch Document Views
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© Click View.
The View tab appears.

© Click one of the buttons in the Views group on the Ribbon: Read Mode, Print Layout, Web
Layout, Outline, or Draft.
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Word switches your document to the view you selected.

Note: In this example, the document switches from Print Layout view to Outline view,
showing two outline levels.

@ In Outline view, the Outlining tab appears on the Ribbon.

© Buttons for three of the views also appear at the right edge of the status bar; move the
pointer ([l?) over each button to see its function, and click a button to switch views:
=—Read Mode
»—Print Layout
»—Web Layout

Understanding Document Views

You can control the way that you view your document by choosing from five different views:
Read Mode, Print Layout, Web Layout, Outline, and Draft.

Read Mode View
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Read Mode view, which supports tablet motions, optimizes your document for easier
reading and helps minimize eyestrain when you read a document on-screen. This view
removes most toolbars. To return to another view, press :; alternatively, click View, and
then click Edit Document.

Print Layout View
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Print Layout view presents a “what you see is what you get” view of your document. In Print
Layout view, you see elements of your document that affect the printed page, such as
margins, headers, and footers.

Web Layout View
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Web Layout view is useful when you are designing a web page because it displays a web
page preview of your document.

Draft View
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Draft view is designed for writing and editing text; it displays text formatting, but it does not
display your document the way it will print. Instead, you can view elements such as the Style
Area—which shows the formatting style for each paragraph—on the left side of the screen,
but you cannot view certain document elements such as graphics or the document’s
margins, headers, and footers.

Outline View

F Cormag

Outline view helps you develop and edit the organization of a document. Word indents text
styled as headings based on the heading number; you can move or copy entire sections of a
document by moving or copying the heading. You also can display the Style Area to show
the style names.

Work with the Navigation Pane

Word’s Navigation pane helps you navigate through long documents. The Navigation pane
appears on the left side of the Word window and contains three tabs: the Headings tab, the
Pages tab, and the Results tab.

The Headings tab displays the document’s headings in a collapsible view that works like a
smaller version of Outline view. You can expand and collapse headings, as needed. The
Pages tab displays page thumbnails that enable you to navigate quickly by eye. The Results
tab enables you to navigate among search results and among objects, such as graphics,
tables, or comments.
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Work with the Navigation Pane
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Navigate Using Headings

Note: To navigate using headings, your document must contain text styled with Heading
styles. See Chapter 6 for details on styles.

© Click View.
The View tab appears.

© Click Show.
The Show pop-up panel appears.
© Click Navigation Pane (o changes to ).
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@ The Navigation pane appears.
@ Heading 1styles appear at the left edge of the Navigation pane.
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@ Word indents Heading 2 styles slightly and each subsequent heading style a bit more.

© The Collapse icon () represents a heading displaying subheadings; you can click it to hide
the subheadings.

© The Expand icon (.) represents a heading hiding subheadings; you can click it to display the
subheadings.
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© Click to select any heading you want to display.
@ Word moves the insertion point to that heading in your document.

Navigate by Page

@ Click Pages.
@ Word displays each page in your document as a thumbnail.
© Click a thumbnail.

@ Word selects that page in the Navigation pane and moves the insertion point to the top of
that page. Word surrounds the current page’s thumbnail with a heavy blue border.
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How do | control what headings appear?

On the Headings tab in the Navigation pane, right-click any visible heading to display the
context menu. Click or highlight Show Heading Levels to display the Show Heading Levels
submenu, and then click the lowest heading level you want to display. For example, click
Show Heading 3 to show Heading 1, Heading 2, and Heading 3 levels.

Using Focus Mode

When you need to concentrate on the contents of a document rather than its formatting or
layout, you can switch on Focus mode from the Ribbon or from the status bar. Focus mode
hides the title bar and window frame, the Ribbon, the status bar, and the scroll bars, leaving
the document’s contents displayed full screen.

When you need to use the Ribbon, you can display it temporarily by moving the mouse
pointer up to the top of the screen. You can then issue a command as usual. Once you have
done so, the Ribbon hides itself again.

Using Focus Mode
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© Click View.
The View tab appears.

© Click Focus.

Note: If Focus Mode () appears on the status bar, you can click it to switch to Focus mode.
To add this button, right-click the status bar, and then click Focus on the Customize Status

Bar menu that opens.
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The Bread Baking Newsletter

Word displays the document in Focus mode, hiding almost all the controls.

© When you need to use the Ribbon, move the pointer to the top of the screen.

The Ribbon reappears.

You can issue a command as usual.

© When you want to stop using Focus mode, click Restore Down ().

Note: You can also click Focus Mode (g) on the status bar to stop using Focus mode.
Alternatively, press

Word switches back to the view you were using before.

Using Immersive Reader

When you need an even more focused reading experience than Focus mode provides, you
can use Word’s Immersive Reader feature. Immersive Reader provides a set of tools to help
you focus on the document’s text.

Immersive Reader enables you to narrow the focus to one line, three lines, or five lines. You
can change the length of those lines by adjusting the column width setting, from Very
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Narrow through Narrow and Moderate to Wide. You can have Word add spacing between
the characters, display syllable breaks, and even read the text aloud.

Using Immersive Reader
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© Click View.
The View tab appears.

® Click Immersive Reader.
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Word switches the document to Immersive Reader view.
@ The Immersive Reader tab appears on the Ribbon.
© Click Column Width, and then click Very Narrow, Narrow, Moderate, or Wide.

© Click Page Color, and then click the page color you want.

© Click Line Focus, and then click None, One Line, Three Lines, or Five Lines, as needed.
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Immersive Reader applies the settings you chose.

© You can click Text Spacing to add spacing between letters and between lines.
@ You can click Syllables to display syllable breaks.

© You can click Read Aloud to have Word read the text aloud.

O Click Up (.) to scroll up, or click Down (.) to scroll down.

@ When you finish using Immersive Reader, click Close Immersive Reader.
Word switches the document back to the view you were using before.
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Chapter 2: Creating and Saving Documents

In this chapter, you learn how to create new documents and save them either to your
computer or to OneDrive. You also explore how to work with different document formats,
switch between open documents, and recover unsaved documents.
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Start a New Document

Each time you open Word, the Word Start screen offers you a variety of choices, including
several ways to begin a new document. But you can also start a new document while you
are already working in Word.

You can use a template—a document containing predefined settings that saves you the
effort of creating the settings yourself—as the foundation for a document. Word’s Start
screen and the New pane in Backstage View offer a variety of templates.
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Start a New Document
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@ With a document already open in Word, click File.
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Backstage View appears.

© Click New.

The New pane appears.

@ Templates appear in the main part of the New pane.
@ You can search for templates online at templates.office.com/en-US.

© You can click a button in the Suggested Searches list to search for templates in a particular
category.

© Click a template.

Note: This example uses Blue grey resume.
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Mew

A preview of the template appears.

© Click Create.

Note: If you change your mind about the template you chose in step 3, click - in the upper-
right corner of the preview. Word redisplays Backstage View, showing the choices when you
click New.
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© The new document based on the template you chose appears.
You can edit this document any way you choose.

© Word gives the new document a generic name, such as Document2. When you save the
document, as explained in the next section, you give the document a permanent name.

When | save the document, am | overwriting the settings in the
template?
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No. The document contains the settings found in the template, but saving the document
has no effect on the template. The next time you choose to use that template, it will
contain its original information. Think of it this way: a blank document is based on the
Normal template, which contains no text, but it contains other settings such as fonts, font

sizes, line spacing settings, and margins.

Save a Document to Your Computer

You save documents so that you can use them at another time in Microsoft Word. Word can
save documents in various formats, but you will normally want to use the default format,
which is called “Word Document (¥*.docx).” See the first tip in this section for brief details of
the advantages of the Word Document format.

The first time you save a document, Word prompts you to specify a name for the document.
Once the document has a name, you can click the Save button on the Quick Access Toolbar
or press the tm + o shortcut to save changes quickly.

Save a Document to Your Computer

TTLTNE
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Note: To avoid losing work, save each document immediately after you create it. After that,
save the document whenever you have made changes that you would not want to have to

make again.

© Click Save ().
The Save This File dialog box opens.

Note: The Save This File dialog box lets you save documents in only a few locations.
Displaying the Save As pane in Backstage View gives you access to all your locations.
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© Click More save options.
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The Save As pane in Backstage View appears.

@ Locations where you can save files appear here.

Note: Once you select a location, folders available at that location appear on the right side of
the screen.

© Click the location where you want to save the file; this example uses This PC.

O If the folder in which you want to save the document appears here, click it and skip to step
5.

© Click Browse.
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The Save As dialog box opens.
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© Type a name for the document here.

@ You can click in the folder list to select a location on your computer in which to save the
document.

© You can click New folder to create a new folder in which to store the document.

O Click Save.
- F— e -_-... ..-’.- ----- - ' ax T = . ;I-
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Word saves the document.

@ The title bar shows the document’s name.

@ The title bar shows Saved to this PCto let you know the document is saved to your
computer rather than to the Cloud.

@ After making changes you want to keep, click Save (&) to save the changes.

Note: You can also press = + i to save the document.

TIPS

What are the advantages of the Word Document (*.docx) format?

The Word Document format has two main advantages. First, it reduces the amount of
space needed to store a document. Second, it makes the document more resistant to
corruption and improves your chances of recovering your work if a problem occurs, such as
Word or your computer crashing. This format uses XML—the Extensible Markup
Language—to provide structure and integrity for the file’s contents.

How can | verify that the active document uses the Word .docx
format?

Look at the document name in the title bar. The title of a document saved in a different
format appears with “Compatibility Mode” in the title bar.
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Save a Document to the Cloud

If you get Word through an Office 365 subscription, Microsoft gives you online storage
space on its OneDrive cloud service. For example, an Office 365 Home subscription provides
up to 1 TB—one terabyte, which is 1000 gigabytes—of space for each of up to six users.

OneDrive stores files in a folder on your PC and syncs that folder automatically to the
OneDrive cloud. So each time you save a document in Word, the changes are saved first to
your PC and then synced to the cloud.

Save a Document to the Cloud
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© Create a new document, as discussed in the section “Start a New Document,” earlier in
this chapter. For example, click File, and then click New to open the New pane in
Backstage View; then click Blank document or a template of your choice.

Note: Alternatively, open an existing document that you want to save to the Cloud.

© Enter any initial text needed, such as the document’s title.

€ Click File.



Save As
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Backstage View appears.
O Click Save As.
© Click your OneDrive.
© The list of folders appears.

O If the folder where you want to save the document appears in these lists, click that folder;
otherwise, click Browse.
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The Save As dialog box opens.
@ Click your OneDrive in the folder list.
© Open the OneDrive folder where you want to place the document.

© Type a filename.
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Note: If you opened the document from your OneDrive space, you will be prompted to
replace it; click Yes.

€D Click Save.

© Word saves the document and uploads it to OneDrive.

How do | prevent Word from automatically synchronizing with my

OneDrive?
Perform the steps that follow: Click File, and then click Options to display the Word Options
dialog box. Click Save in the left pane. Select Save to Computer by default (- changes to =),

and then click OK.

Recover an Unsaved Document

You can open documents you created within the last seven days but did not save. Normally,
it is best to save every document you create, but you may sometimes create a document,
work init, and then close it without saving because you think you will not need it again. And
then, a few hours or days later, you find that you do need it.

You can reopen a document you created within the last seven days but did not save because
Word automatically saves your documents in case problems occur.
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Recover an Unsaved Document
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© With any document open, even a blank document, click File,

Note: See the section “Start a New Document” or “Open a Word Document” for details.

Backstage View appears.

© Click Info.
The Info pane appears.

© Click Manage Document.
The Manage Document pop-up menu opens.

© Click Recover Unsaved Documents.
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The Open dialog box appears, showing you available files that Word saved automatically
but that you did not save as documents.
© Click the unsaved file you want to open.

O Click Open.
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0 The document opens.

0 The gray Recover Unsaved File bar identifies the document as a recovered file temporarily
being stored on your computer.

© Click Save As.
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The Save As dialog box opens.

© Navigate to the folder in which you want to save the document. For example, click
OneDrive, and then click the appropriate folder.

© Edit the suggested file name, or type a new filename over it.
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@ Click Save.
The Save As dialog box closes.
Word saves the document and removes the gray Recover Unsaved File bar.

TIPS

How often does Word save a document while | work on it?

By default, Word automatically saves your work—even on documents you have not yet
saved—every 10 minutes. If you work quickly, this is far too seldom. You can reduce the
auto-save interval by changing the options for saving documents; see the section “Set
Options for Saving Documents” for details.

Is there another way to open the dialog box that shows unsaved
documents?

Yes. Click File, and then click Open. At the bottom of the Recent Documents list in
Backstage View, click Recover Unsaved Documents.

Save a Document in a Different Format

You can save documents you create in Microsoft Word in a variety of other formats, such as
Word templates, Word macro-enabled documents, OpenDocument Text files, or even plain-
text files. One outdated format you may need to use is the Word 97-2003 format, which
Word used by default up to Word 2003 for Windows and Word 2004 for Mac.

This section shows you how to save a document to Word 97-2003 format, but the steps for
using any other file format that Word supports are similar.

Save a Document in a Different Format
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© with the document open, click File.
Backstage View appears.

© Click Save As.
The Save As pane appears.
© Click This PC.

@ If the folder in which you want to save the document appears in this list, click it and skip to
step 6.

O Click Browse.
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The Save As dialog box opens.
© Click the folder you want to save the document in.
© Type a name for the document.

@ Click « to display the formats available for the document, and click Word 97-2003
Document.

© Click Save.

Note: If you save a complex document, you might see the Compatibility Checker dialog box,
which summarizes changes Word will make when saving your document. Click OK.

The Save As dialog box closes.
Word saves the document in the format you chose.
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Save a Document in PDF or XPS Format

You can save Word documents in PDF or XPS formats. The PDF format is a universal format
that any computer user can open using a PDF reader program. There are many free PDF
reader programs; perhaps the most well-known one is Adobe Systems’ free Acrobat Reader.
Windows 8 and Windows 10 come with a built-in PDF reader.

XPS is Microsoft’s alternative to PDF. Windows 10, Windows 8, and Windows 7 come with an
XPS viewer; users of other versions of Windows can view XPS documents using Internet
Explorer 7 or higher.

Save a Document in PDF or XPS Format
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© With the document open, click File.
Backstage View appears.

© Click Save As.
The Save As pane appears.
© Click This PC.

O If the folder in which you want to save the document appears in this list, click it and skip to
step 6.

© Click Browse.
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The Save As dialog box opens.
© Click the folder in which you want to store the new file.
O Click here and type a name for your document.

© Click to select either PDF (*.pdf) or XPS Document (*.xps).
Note: If you choose XPS format, you can opt to save and then open the document.

© If you plan to use your document online only, you can select Minimum size ( changes to -

).

© Click Save.
Word saves the document in the selected format.

Set Options for Saving Documents

By default, Word saves documents in the Word Document format, which uses the .docx file
extension; automatically saves changes to the documents you store on OneDrive or the
SharePoint Online services; and automatically saves your work every 10 minutes to help you
recover from crashes and other problems.

You can configure Word’s settings for saving documents by working in the Save category of
the Word Options dialog box. For example, you may want to reduce the AutoRecover
interval from 10 minutes to a shorter period.
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Set Options for Saving Documents
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Click File.

Backstage View appears.

© Click Options at the bottom of the left pane.
Note: You may need to scroll down to see the Options button.
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The Word Options dialog box opens.
© Click Save.

O Select AutoSave OneDrive and SharePoint Online files by default on Word () if you want
Word to save your Cloud files automatically.

© Select Save AutoRecover information every (=) and specify an interval for saving recovery
information.
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@ Select Keep the last AutoRecovered version if | close without saving (=) to make sure
Word saves unsaved documents.
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@ If you want to save documents to your computer rather than to OneDrive, click Save to
Computer by default (o changes to g).

© Click Browse next to Default Local File Location.
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The Modify Location dialog box opens.
© Navigate to the folder where you want Word to save documents by default.

© Click OK.
The Modify Location dialog box closes, returning you to the Word Options dialog box.

You can repeat steps 7 to 9 to set the AutoRecover File locations.
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@ Click OK.
The Word Options dialog box closes.
Word saves your changes.

What happens if | select the Don’t Show the Backstage When
Opening or Saving Files option?

To take full advantage of this option, you need to add the Open button and the Save As
button to the Quick Access Toolbar. When you opt not to show Backstage View, and then
click the Open button or the Save As button, Word displays the Open dialog box or the Save
As dialog box without showing Backstage View. If you are comfortable navigating folders,
enabling this option saves you time. See Chapter 11, “Customizing Word,” for instructions
on customizing the Quick Access Toolbar.

Open a Word Document

You can open documents that you have created and saved previously to continue adding
data or to edit existing data. Regardless of whether you store a file in a folder on your
computer’s hard drive or online, you can easily access files using the Open dialog box. If you
are not sure where you saved afile, you can use the Open dialog box’s Search function to
locate it.

When you finish using a file, you should close it to free up processing power on your
computer. See the second tip in this section.
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Open a Word Document
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© Click File.
Backstage View appears.
© Click Open.

@ Word automatically selects Recent as the default location.

@ Recently opened documents appear here. If you see the file you want to open, you can
click it to open it and skip the rest of these steps.
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© Click Browse.
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The Open dialog box appears.
O Click the folder that contains the document you want to open.

@ If you chose the wrong place, you can search for the file by typing part of the filename or
content here.

© Click the document you want to open.

O Click Open.
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The document appears on-screen.

© To close afile, click « in the upper-right corner. If you have not saved the file, the program
prompts you to save it.

What if | cannot find my file?
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You can use the search box in the upper-right corner of the Open dialog box to locate files.
Complete steps 1to 3 to display the Open dialog box. Locate and open the folder in which
you believe the file was saved and type the file’s name in the search box. Files containing
the search term appear highlighted along with files containing a close match.

How do I close a document?

While viewing the document, click File to display Backstage View, and then click Close.

Open a Document That Uses a Different Format

You can open and edit documents created in other word processing apps or text editors.
Word can open XML, web page, rich text, plain-text, OpenDocument, PDF, WordPerfect 5.x
or 6.x, or Works 6—9 documents as well as documents created in earlier versions of Word.

Although you can open and edit PDF files, editing PDF files in Word works best if you used
Word to originally create the PDF file. If you used a different program to create the PDF file,
you may find that Word has difficulty maintaining the file’s formatting.

Open a Document That Uses a Different Format

© Click File.
Backstage View appears.

© Click Open.
@ You can click Recent to see a list of recently opened documents. If you see the file you
want to open, you can click it to open it and skip the rest of these steps.

© Click the place where you think the document is stored. This section uses This PC.
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O If the folder containing the document appears here, click it and skip to step 5.

© Click Browse.
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The Open dialog box appears.

© Click in the folder list to navigate to the folder containing the file you want to open.

O Click «, and then click the type of file you want to open.
The Open dialog box shows files of that type.
@ Click the file you want to open.

© Click Open.
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Salsa Recipe ;

In i

& 1 Ib. tomatoes, as ripe as possible

# 1 bunch cilantro (fresh)|

& 4 cloves garlic

= 3 chili pappers

= 1 small can habaners peppers (apthonal)

Method
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If you open a PDF file, Word displays a message indicating that it is converting your PDF file
to an editable Word document; click OK to continue.
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Note: You may be prompted to install a converter to open the file; click Yes or OK to install
the converter and open the file.

@ Word opens the file.

O The title bar shows Compatibility Mode to indicate that the file is not in Word Document
format.

© To save the file in Word Document format, click File.
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Backstage View appears.

@ Click Save As.
The Save As pane appears.
@ Click «, and then click Word Document (*.docx).

& Click Save.
Word saves the file in the Word Document format.

How do | open an XPS file?

Although you can create an XPS file in Word, you cannot open the file in Word. Instead, you
can use an XPS viewer, or in Windows 10, you can use the Reader app. To open an XPS file,
find it using File Explorer and double-click it.
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Open a Document from the Cloud

Storing your documents on OneDrive enables you to access them from anywhere and makes
it easy to work on the same documents on all your devices. For example, you can start a
document on your PC, work on the document on your phone or tablet while out and about,
and then resume work seamlessly on your PC.

Documents stored in your OneDrive folder are automatically synced with your cloud storage,
keeping all versions up to date.

Open a Document from the Cloud
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© Make sure you have signed in to your Microsoft 365 subscription by looking for your name
here.

© Click File.
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Backstage View appears.
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© Click Open.
© Word automatically selects Recent as the default location.

O Click the appropriate OneDrive account. This example uses the personal OneDrive
account.
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© You may also have a business OneDrive account.
@ You may also have access to one or more SharePoint servers.
The contents of that OneDrive appear.
© Navigate to the folder that contains the document you want to open.
© You can use the search box to search the current folder using keywords.

@ Click the document you want to open.
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The document opens, and you can edit it as normal.
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O By default, Word sets the AutoSave switch to On for a document stored on OneDrive or
SharePoint. When AutoSave is On, you do not need to save changes manually.

What happens if | leave a OneDrive document open on my PC and

then change the document on my phone?

As long as you leave the AutoSave feature enabled, OneDrive automatically synchronizes
the changes you make across the different versions of the document. In this case, when
you return to your PC, OneDrive will have updated the document with the changes you
made on your phone.

Switch Between Open Documents

Word enables you to open as many documents as you need and to switch between them
quickly. For example, you may need to copy information from one document to another, or
you may simply need a change of focus.

You can switch between your open documents either by using the Switch Windows menu on
the View tab of the Ribbon in Word or by using the Windows taskbar.

Switch Between Open Documents

Switch Documents Using Word

© Click View.
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The View tab appears.
© Click Switch Windows.
@ The menu displays a list of all open documents.
© A check mark (+) appears beside the currently active document.

© Click the document you want to view.
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The selected document appears.

Switch Documents Using the Windows Taskbar

© Position the mouse (E:;) over the Word button in the Windows taskbar.
O Preview thumbnails appear for each open document. The document over which you
position the pointer ([E) also previews in Word.

© You can close a document by moving the pointer over a thumbnail, and then clicking Close

()-
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© Click the preview of the document you want to display.
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The document appears.

How can | keep the taskbar buttons separate from each other instead

of stacked on top of each other?

Right-click the clock readout, and then click Taskbar Properties in the context menu that
opens. The Taskbar screen in the Settings app appears. Click Combine taskbar buttons (),
and then click Never; alternatively, click When taskbar is full to stack the buttons only when
the taskbar is full. Click Close (-) to close the Settings app.

Compare Two Documents Side by Side

When you need to compare two documents, you can use Word’s View Side by Side feature,
which places the documents in equally sized windows alongside each other, making the
contents easy to compare. The View Side by Side feature also provides two helpful features:
First, it synchronizes the scrolling of the two windows, so when you scroll one window up or
down, and the second window follows suit; and second, it synchronizes the zoom, enabling
you to zoom both windows in or out together.
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Compare Two Documents Side by Side

__Agenda

@ Open the two documents you want to compare and make one of the documents active.

@ Click View.
The View tab appears.

© Click View Side by Side (=).
The Compare Side by Side dialog box opens, showing a list of your other open documents.

Note: If you have only two documents open, the Compare Side by Side dialog box does not
open. Go to step 6.

O Click the second document for the comparison.

© Click OK.
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The Compare Side by Side dialog box closes.
Word displays the documents in two panes beside each other.

O Drag either document’s scroll bar.

Word scrolls both documents simultaneously.

Note: You can also zoom both documents simultaneously by dragging the zoom slider on
the status bar.

© When you are ready to stop comparing the two documents, click View in the document
that you want to keep viewing.

The View tab appears.

© Click Window.
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The Window panel appears.
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© Click View Side by Side.
Word expands the document to its previous size.

Note: The second document remains open.

What does the Reset Window Position button do?

When you are comparing documents side by side, the Reset Window Position button has
no effect. But you can use Arrange All to place one window above the other, each in its
own separate pane. To return to side-by-side viewing, click Reset Window Position.
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